
Software User Guide

•	 Read all safety precautions thoroughly to ensure safe use.
•	 Types of software installed on your computer varies depending on the method of installation from the 

Software CD-ROM. For details, see the “Camera User Guide”
•	 For information on the operating systems that support the Software CD-ROM, see the “Camera User 

Guide”.
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Using These Manuals
The two manuals included are for your G700SE.

1.	 Understanding How to Use Your 
Camera

“Camera User Guide” (Printed manual)
This guide explains the usage and functions of 
the camera. You will also see how to install the 
provided software on your computer.

2.	 Downloading Images to Your 
Computer

“Software User Guide” 
*This manual (this file)

This guide explains how to download images 
from the camera to your computer.

3.	 Displaying Images on Your 
Computer

The provided software “MediaBrowser” (for 
Windows only) allows you to display and edit 
images on your computer.
For details on how to use MediaBrowser, click 
the [?] button on the MediaBrowser window 
and see the “Help”
For the latest information about MediaBrowser, 
access the Web page of Pixela Co., Ltd. (http://
www.pixela.co.jp/oem/mediabrowser/e/).

How to Use the Software User 
Guide
Display examples:
The display examples may be different from actual 
display screens.

Terms:
In this guide, still images and movies are 
referred to as “images” or “files”.

Symbols:
This guide uses the following symbols and 
conventions:

This indicates important notices and restrictions 
for using this camera.

This indicates supplementary explanations and 
useful tips about camera operations.

This indicates page(s) relevant to a particular 
function. “GP. xx” is used to refer you to pages 
in this manual.

This indicates terms that are useful for 
understanding the explanations.

http://www.pixela.co.jp/oem/mediabrowser/e/
http://www.pixela.co.jp/oem/mediabrowser/e/
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Chapter 1   
Downloading Images 
to Your Computer 
(Windows)

This section explains how to download still images and movies to 
your computer (Windows).
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Downloading Images
There are two methods for downloading 
images from the camera to your computer.

1.	 Downloading images without using 
image download software such as 
DL‑10 (GP.6).
The camera is recognized by the computer 
as a separate drive and appears on [My 
Computer]. Select and copy images.

2.	 Use image downloading software such 
as DL‑10 to download all images to the 
computer (GP.7).
To use DL‑10, DC Software must be installed. 
For information on how to install 
DC Software, see the “Camera User Guide”.

•	 Do not turn off the camera or disconnect the 
USB cable during image transfer. The files will 
not be written correctly.

•	 Do not use the computer to format the SD 
memory card or the internal memory. Use the 
camera to format the SD memory card or the 
internal memory.

•	 Be sure to stop the connection before 
removing the USB cable.

•	 The camera can not display pictures that 
have been transferred to the computer using 
“Windows Photo Gallery” (Windows Vista) or 
“Windows Live Photo Gallery” (Windows 7) and 
then copied from the computer to a memory 
card which is subsequently inserted in the 
camera.

•	 Only one Ricoh digital camera can be 
connected to one computer. Do not connect 
multiple Ricoh cameras to one computer at the 
same time.

•	 The names for DC Software items differ from 
the names for Caplio Software items provided 
with previous models as shown below.

Caplio Software DC Software

RICOH Gate La DL-10

Caplio Viewer DU-10

Caplio Server SR-10

Caplio Setting ST-10

•	 When downloading images from your camera, 
load a battery with adequate remaining power 
in the camera.

•	 If there is an SD memory card in the camera, 
images will be loaded from the card. If there is 
no SD memory card in the camera, images will 
be loaded from the internal memory on the 
camera.

•	 The software included in the CD-ROM can only 
be used with Windows.
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Downloading Images Without 
Using DL-10

1.	 Make sure that the camera power is 
off.

2.	 Connect the accessory USB cable to 
a USB port of your computer.

3.	 Connect the USB cable to the USB 
terminal of your camera.

Your camera turns on.
Your computer automatically reads the file 
necessary for recognizing the camera as a 
drive. 
After this preparation, the camera is 
displayed as a drive at [My Computer].

Example of the display in Windows XP

4.	 From the displayed drive, copy a 
file to the desired location.
The figure below shows the folder 
configuration of the drive.

When the contents of the internal memory 
are displayed, the drive name is [RICOHDCI].

•	 If a file with the same name already exists at 
the destination, it is overwritten.

•	 If DC Software is installed, clear the check 
box next to the [Saves automatically when 
connected to USB] option in the DL-10 [Option 
settings] dialog box.
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Downloading All Images 
Using the DL-10 Software
DL-10 automatically creates a folder called 
[Digital Camera] inside your [My Documents] 
folder. Downloaded images are saved in 
folders with the date of each shot, inside the 
[Digital Camera] folder. (The files will continue 
to be saved in the [Caplio] folder if you were 
previously using Caplio Software.) 

Set the correct date and time on the camera 
before shooting.

1.	 Make sure that the camera power is 
off.

2.	 Connect the USB cable to the USB 
port of your computer.

3.	 Connect the USB cable to the USB 
terminal of your camera.

The camera turns on, DL-10 starts, and the 
DL-10 window appears.

Image transfer begins automatically.

If image transfer does not begin, please try 
the following procedures:
•	 Click the [Save] button in the DL‑10 

window.
•	 Restart your computer and perform 

Steps 1 to 3 again.
•	 Confirm that the [Saves automatically 

when connected to USB] checkbox in the 
[Option settings] dialog box for DL‑10 is 
selected.

•	 When the [The same image will not be saved] 
check box is selected in DL-10 [Option settings] 
(GP.11), the total number of files that can 
be transferred at one time is 999. To transfer 
1000 files or more, transfer 999 files first and 
then click [OK] when the dialog box with the 
number of remaining files appears. After that, 
click the [Save] button in the DL‑10 window 
or reconnect the USB cable to transfer the 
remaining files.

•	 Do not turn off the camera or disconnect 
the USB cable during image transfer using 
DL‑10 (when the message for receiving data is 
displayed).

•	 The images on the computer are renamed 
using consecutive file numbers; the file names 
assigned by the camera are not used.

•	 Even when the storage folder is changed, the 
file number will be continuous. The number 
cannot be initialized.

•	 When transferring images to a computer 
using DL-10, the files are assigned names like 
[RIMG****.jpg] (**** indicates the number of 
the image), even if [Card Sequence No.] is set 
to [On].

•	 For details about DL‑10, see P.9.
•	 For details about the DL‑10 [Option settings] 

dialog box, see P.11.
•	 To disconnect the camera from your computer, 

see P.9.
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Warning Messages Under 
Windows XP Service Pack 3 and 
Windows Vista Service Pack 2
When software for your Ricoh digital camera 
is used on a computer running Windows Vista 
Service Pack 2 or on a computer with 
Windows XP Service Pack 3 installed, a warning 
message similar to the one shown below 
may appear at software activation or USB 
connection. Change the computer settings 
while referring to the information below.

A screenshot of the warning message in 
Windows XP is shown below.

When warning messages appear:
After checking the program name and publisher, 
click [Unblock].

If you do not recognize the program, you should 
block it because it may be a virus. Click the [Keep 
Blocking] button to prevent the program from 
connecting to the Internet.

If you clicked the [Ask Me Later] button:
Each time the program is activated, the 
[Windows Security Alert] window appears. Then 
you can select [Unblock].

If you clicked the [Keep Blocking] button:
Follow the steps below to check to see the 
Windows Firewall settings.

1.	 Open the [Windows Firewall] 
Control Panel.

Open the [Start] menu and select [Control 
Panel], then double-click [Windows 
Firewall] (if Windows Firewall is not 
listed,click [Switch to Classic View] at 
the top left corner of the Control Panel 
window).

2.	 Allow the Ricoh application 
Internet access.

In the [Windows Firewall] dialog,click the 
[Exceptions] tab and check whether DL-10 
is listed under [Programs and Services]. If 
it is, place a check in the check box next to 
DL-10 and click OK. If it is not listed,click 
[Add Program…] to add DL-10 to the list of 
exceptions.
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Windows 7 Security Warning
On computers running Windows 7, you may 
encounter the following warning when starting 
Ricoh software for digital cameras either 
manually or by connecting a camera:

When warning messages appear:
After checking the program name and publisher, 
click [Allow access].

Disconnecting the Camera 
from Your Computer
Before disconnecting the camera from the 
computer, click the [Safely Remove Hardware] 
or [Unplug or Eject Hardware] icon in the 
taskbar (the illustration below shows the icon 
for Windows XP) and select [Safely remove 
USB Mass Storage Device] or [Stop USB Mass 
Storage Device] from the menu that appears. 
You can then disconnect the USB cable.

If the remove hardware icon is not displayed in 
Windows 7, click the  button in the taskbar.

•	 If the USB cable is disconnected without 
disabling the connection, the Unsafe Removal 
of Device screen may be displayed.

•	 Do not disconnect the USB cable during 
image transfer. Check that image transfer is 
completed and be sure to stop the connection 
before removing the USB cable.

Detailed Instructions for DL‑10
Starting/Exiting DL‑10

Starting
DL‑10 is already installed with DC Software.

Connecting the camera to your computer 
automatically starts the software and begins 
downloading of images from the camera.

Exiting
To exit DL-10, follow either of the steps below.

•	 Click the [MENU] button on the DL‑10 
window and select [Exit] from the displayed 
menu (see “The DL‑10 Window”).

•	 Right-click the DL‑10 icon on the task bar and 
select [Exit] from the displayed menu.

Restarting
To restart DL‑10 after exiting, follow the steps 
below.

•	 From the [Start] menu, select [All Programs] 
or [Programs] then [DC Software] then 
[DL‑10].

DL‑10 is not network-compatible. Use as a stand-
alone application.
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The DL‑10 Window
Once DL‑10 starts up, the following DL‑10 
window appears on your computer screen.

1	 [MENU] Button

Click this and the following menu appears.

[Option settings] Specifies where to save 
images when downloading 
all images and which 
application to start after 
images have been saved 
or when the [Application] 
button is clicked. (GP.11)

[Background 
illustration 
settings]

Changes the background 
design in the DL-10 window. 
(GP.12)

[CameraMemo] Transfer images (GP.19) to 
destinations selected based 
on the presence or absence 
of a memo (GP.12) and 
memo contents.

[About] Displays the version of DL‑10.

[Exit] Closes DL‑10.

2	 [Save] Button

Click this and the images are downloaded 
from your camera.

If the message indicating that [Connecting... 
Press [Adj.] key to direct print] appears on the 
camera picture display, do not click the [Save] 
button.

3	 [Application] Button

The application registered in [Option 
settings] is started.

4	 [Minimize] Button

Minimizes the window and displays its icon 
on the Windows task bar. If you click on the 
icon, the window will be displayed again.

5	 Indicator

The “Indicator” lights if the camera is 
connected via USB cable. When lit, if you 
move the mouse pointer over the “Indicator”, 
[Camera is being connected] appears. When 
your camera is not connected, the “Indicator” 
is grayed out, and if you move the mouse 
pointer over it, [Camera is being connected] 
does not appear.
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How to Use the [Option settings]
If you click the [MENU] button on the DL‑10 window and select 
[Option settings] from the displayed menu, the [Option settings] 
dialog box appears.

Note that uninstalling the software for earlier Ricoh cameras may 
reset user preferences for DL‑10 or RICOH Gate La.

Item Description Initial Setting

1 [Saves 
automatically 
when connected 
to USB]

Select the check box to have images downloaded and saved automatically 
in your computer when the camera is connected to your computer with the 
USB cable. 
If you deselect the check box, your images will not be downloaded 
automatically when you connect your camera to the computer. For 
downloading, activate DL-10 and click the [Save] button.

Save 
automatically

2 [Destination folder] Specifies which folder to save your images in. The [Digital Camera] folder 
inside [My Documents] is specified initially; if you want to change this, click 
the [Browse...] button to display the dialog box and then specify the folder.

———

3 [Create folder] Specifies how to create a folder.
[Not created]

Your downloaded images will all be saved in the folder specified in item 
“2 [Destination folder]”.

[For each date photographed]
Creates a new folder assigning the date the images were shot as the folder 
name, and saves images shot on the same day in the same folder.
For example, if shot on January 1, 2010: [20100101] folder

[For each time saved]
Creates a new folder each time and save images in the folder. If images are 
saved more than once in a day, a new folder is created each time.
The folder name format is “Saving date + Underscore + Three-digit serial 
number”.
For example, if you saved twice on January 1, 2010: 
[20100101_001] folder, [20100101_002] folder

Create a new 
folder for 
each date 
photographed

4 [The same image 
will not be saved]

When this check box is selected, images once loaded into your computer are 
not loaded again. This check box is enabled only when [Not created] or [For 
each date photographed] is selected in [Create folder].
To allow this function to work properly, the camera date and time must be set 
correctly.
When this check box is deselected, previously loaded images are loaded 
again.
*	 If you were previously using Caplio Software, images will be downloaded 

again if images downloaded using RICOH Gate La remain on the SD 
memory card even if the [The same image will not be saved] checkbox for 
the DL‑10 [Option settings] is selected.

The same 
image will not 
be saved

5 [Application 
software settings]

To start an application after loaded images have been saved, specify the 
application name here. Click the [Browse...] button and select the application 
in the displayed dialog box.

———

6 [Save and start 
application 
software]

When this is checked, the application specified above is started after the 
images have been saved.
When this is unchecked, the application is not started.

Application is 
started

7 [Camera's IP 
Address]

Not used for this camera, but used for other Ricoh digital cameras. For details, 
see the documentation that came with the camera.

0.0.0.0
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How to Use the [Background 
illustration settings]
You can select a background for the DL-10 
window from three types of patterns.

If you click the [MENU] button on the DL-10 
window and select [Background illustration 
settings] from the displayed menu, the 
[Background illustration settings] dialog box 
appears.

1	 [Background illustration pattern]

Select the pattern you wish to use from the 
three available.

2	 [Preview]

You can preview the pattern selected in 
[Background illustration pattern].

Using [CameraMemo Settings]
Transfer images to destinations selected 
based on the presence or absence of memos 
and memo contents. Click the [MENU] button 
and select [CameraMemo] to display the 
[CameraMemo Settings] dialog.

1	 [Transfer From]

Choose the source from [Memory Card 
(specify drive or folder)] and [Digital Camera] 
in the [Type] menu. If you select [Memory 
card (specify drive or folder)], click the 
[Browse...] button and navigate to the desired 
source folder.

2	 [Save To]

Click [Browse...] and choose the destination 
for the transferred files. The destination type 
is fixed and can not be changed.

3	 [Settings...]

Clicking this button displays the [Setting 
Information] dialog, where you can adjust 
each of the transfer settings listed below by 
double-clicking the setting or by selecting 
the setting and clicking [Change...].
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[Overwrite and 
save] (available 
only when [Digital 
Camera] is selected 
for [Transfer From]

Choose whether to include 
images that have already 
been transferred to the 
destination. Select [Do 
not save the same image] 
to skip images that have 
already been transferred.

[Export type] 
(available only 
when [Memory 
Card] is selected 
for [Transfer From])

Choose whether to 
transfer all images or only 
those with memos.

[Transfer mode] Choose whether the sub-
folders in the destination 
folder are named by 
memo description or using 
both memo item names 
and descriptions.

[Launch 
application]

Choose the application 
that starts when transfer is 
complete.

[Confirm File 
Overwrite]

Choose whether a 
confirmation dialog is 
displayed before files in 
the destination folder are 
overwritten by transferred 
files with the same name. 
If you opt not to display 
a confirmation dialog, 
files will be overwritten 
without warning. If [Digital 
Camera] is selected 
for [Transfer From], a 
confirmation dialog 
will only be displayed if 
[Save the same image] is 
selected.

4	 [Begin Transfer]

Click this button to begin transfer (clicking 
this button is the only way to begin transfer 
using [CameraMemo Settings]).

Reserved characters (\ / ; ? * " < > |) are 
automatically converted to underscores (“_”) 
when memo item names and descriptions are 
used as folder names.

Downloading Images from an 
SD Memory Card
It is possible to download images from an SD 
memory card to computer via a PC card slot or 
card reader.

Images in an SD Memory Card
Images are stored on an SD memory card in a 
hierarchy, as shown here.

Image files

If you connect the camera or a card reader to a 
computer and then directly display, edit or save 
SD memory card images on the computer, you 
may no longer be able to play back the images 
on the camera. Download the images to the 
computer before displaying, editing or saving 
them.

Card Reader

This is a device connected to a computer to read 
the contents of cards. In addition to the memory 
card adapter-type, there are card readers into 
which you can directly load an SD memory card.



Chapter 2   
Downloading Images 
to Your Computer 
(Macintosh)

This section explains how to download still images and movies to 
your computer (Macintosh).

Although supplied software can not be used on the Macintosh, 
Macintosh computers can be used to view the “Software User Guide” 
(Acrobat Reader required under Mac OS 9).
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Connecting the Camera to a Com‑
puter and Downloading Images

1.	 Make sure that the camera power is 
off.

2.	 Connect the accessory USB cable to 
a USB port of your computer.

3.	 Connect the USB cable to the USB 
terminal of your camera.

Your camera turns on.
Your computer automatically reads the file 
necessary for recognizing the camera as a 
drive. 
After this preparation, the camera is 
displayed as a drive on the Desktop.

4.	 From the displayed drive, copy a 
file to the desired location.
The figure below shows the folder 
configuration in the drive.

When the contents of the internal memory 
are displayed, the drive name is [RICOHDCI].

•	 Do not turn off the camera or disconnect the 
USB cable during image transfer. The files will 
not be written correctly.

•	 Do not use the computer to format the SD 
memory card or the internal memory. Use the 
camera to format the SD memory card or the 
internal memory.

•	 Be sure to stop the connection before 
removing the USB cable.

•	 Only one Ricoh digital camera can be 
connected to one computer. Do not connect 
multiple Ricoh cameras to one computer at the 
same time.

•	 When downloading images from your camera, 
load a battery with adequate remaining power 
in the camera.

•	 If a file with the same name already exists at 
the destination, it is overwritten. If you do not 
want the file to be overwritten, rename the file 
or transfer data to another folder.

•	 When an SD memory card is loaded, its files 
are displayed. Otherwise, files in the internal 
memory are displayed.
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Disconnecting the Camera 
from Your Computer

1.	 Drag and drop the displayed drive 
or volume icon to the [Trash] icon.
When a screen appears prompting you to 
enter the administrator's password, enter 
the password.

2.	 Unplug the USB cable.

•	 You can also select [Eject] from the [Special] 
menu in Mac OS 9 or the [File] menu in 
Mac OS X to cancel the connection.

•	 A warning may be displayed if the USB cable 
is disconnected without first removing the 
camera from the system as described above. 
Be sure to remove the camera from the system 
before disconnecting the cable.

•	 Confirm that transfer is complete before 
removing the camera from the system and 
disconnecting the cable.

•	 When the camera is connected to a Macintosh 
computer, a “FINDER.DAT” or “.DS_Store” file 
may be created which the camera will list as 
an unmatched file. This file can be deleted 
without risk.

Downloading Images from an 
SD Memory Card
It is possible to download images from an SD 
memory card to computer via a PC card slot or 
card reader.

Images in an SD Memory Card
Images are stored on an SD memory card in a 
hierarchy, as shown here.

Image files

If you connect the camera or a card reader to a 
computer and then directly display, edit or save 
SD memory card images on the computer, you 
may no longer be able to play back the images 
on the camera. Download the images to the 
computer before displaying, editing or saving 
them.

Card Reader

This is a device connected to a computer to read 
the contents of cards. In addition to the memory 
card adapter-type, there are card readers into 
which you can directly load an SD memory card.



Chapter 3   
How to Use EC1

EC1 is an edit detection software program that allows you to check 
and view whether still images taken using the G700SE have been 
processed or edited.

In order to carry out edit detection using EC1, you must set [Edit 
Detection] to [On] in the camera’s shooting setting menu before 
shooting and download the images to your computer.
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Using the Edit Detection 
Function
You can only carry out edit detection using EC1 
after setting [Edit Detection] to [On] on your 
camera, shooting still images, and downloading 
the images to your computer.

1.	 Set [Edit Detection] to [On] in the 
camera’s shooting setting menu, 
and shoot still images.
For operation procedures, see the “Camera 
User Guide”.

2.	 Download the still images shot 
using your camera to your computer.

3.	 Select [Programs] (or [All 
Programs]) > [EC1] > [EC1] from the 
Windows [Start] menu.

4.	 From the EC1 Folder View, select the 
folder for the downloaded images.
The JPEG images in the selected folder 
will be loaded and the images will be 
displayed in Thumbnail View after loading 
is complete.

Folder View Thumbnail View

•	  is displayed with images that have 
not been processed or edited after 
shooting.

•	  is displayed with images that have 
been processed or edited after shooting.

•	 Neither of the above icons is displayed 
with images taken when [Edit Detection] 
was set to [Off ] or images for which edit 
detection is not possible.

•	 By double-clicking an image in the 
Thumbnail View, you can open the 
image using the linked viewer software.

•	 If a space occurs at the beginning or 
end of the folder name, a message will 
appear and no images will be displayed.

•	 Edit detection is available only with 
photographs taken using cameras equipped 
with an edit detection function.

•	 Images for which the [Resize], [Contrast 
Correction], or [Skew Correction] functions 
have been used during playback mode will be 
labeled as images that have been processed or 
edited.

•	 When downloading images to your computer, 
please use the method for downloading 
shown in Chapter 1. Images downloaded 
using different methods may be labeled as 
processed or edited images even if they have 
not been processed or edited.

	 For example, when you download images 
to your computer using “Windows Photo 
Gallery” for Windows Vista or “Windows Live 
Photo Gallery” for Windows 7, a portion of the 
shooting data is edited during the download 
process. As a result, the images are labeled as 
processed or edited images for EC1.

•	 Depending on the software you used to view 
images after downloading them, the images 
may be labeled as processed or edited images 
if you viewed the images or image properties 
before saving or closing them.

•	 For details about how to install EC1, see the 
“Camera User Guide”.

•	 For details about downloading images to your 
computer, see P.5.

Updating Folder Contents
After adding, deleting, or renaming folders, 
select [Reload] in the [View] menu to update 
the folder and thumbnail lists.



Chapter 4   
Shooting with Camera 
Memos

You can attach camera memos (information such as shooting 
conditions) to the still images you shoot. This section explains 
camera memos.

•	 Be sure to set the date and time on the camera.
•	 To use the camera memo function, DC Software must be installed.
•	 Memos are not available with SD WORM memory cards.
•	 The camera memo function is only for use with Windows.

Use ME1 to view and edit the memos that have been appended to 
photographs (GP.40).
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Section 1   
About Camera Memos

Shooting with Camera Memos
The image file storing the image shot with a 
digital camera has an area where additional 
information can be stored. The camera memo 
function uses this area to allow you to attach a 
memo to the still image you shoot.

Memos make photographs easy to identify and 
classify.

•	 Memos can not be added to movies.
•	 Memos can not be added to photographs 

taken with [On] or [WB-BKT] selected for [Auto 
Bracket] in the camera shooting menu.

Camera memo

•	 Photographer
•	 Location, etc.

Image

Additional 
information

Image file

Memos
Memos consist of a list of “items” (tags), each with its own “description” (contents). Memos can be 
added to photographs by pressing the ADJ./MEMO button and selecting the desired descriptions in 
the camera memo dialog before shooting.
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Using Memos

1.	 Create a memo list on the computer and transfer it to the camera (GP.23).
Use the supplied List Editor application to create and transfer to the camera a memo list file 
(extension “.mta”) containing memo item names and descriptions.

2.	 Take photographs with memos (GP.27).
Press the ADJ./MEMO button to display the camera memo dialog (GP.27). After choosing 
descriptions, press MENU/OK to create a memo which will be added to all new photographs (if 
desired, the contents of the memo can be changed after shooting; GP.29).

The following types of memo are available:

1	 Text (GP.23)

Choose from up to 99 text descriptions created with the 
List Editor.
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Cancel Execute

2	 Temporary memo (GP.30)

Use the camera to create a temporary memo using 
descriptions not included in the memo list. The new 
descriptions are not stored in the memo list after the camera 
is turned off.
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3	 Voice memos (GP.33)

Record voice memos of up to 30 seconds in length.
O
00:00/00:30

:Cancel
Shutter button: Start

4	 Barcodes (GP.36)

Create temporary memos using text descriptions from 
barcodes read using the camera.

1234567890
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Barcode
Const.type
Location
Supervisor
Affiliates

FileName/SAMPLE

Camera Memo 1/45

FILE LIST Memo On

5	 Images (GP.38)

To use still images as reference images, include a description 
with an image file name when creating the memo list. 
Note that the image file must first be copied to the camera 
memory card or internal memory.

1/45
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3.	 Transfer the photos to the computer (GP.5).
Copy the photos to the computer using the supplied DL-10 software.

4.	 View and edit memos (GP.40).
Use the supplied ME1 software to display 
photographs, view and edit memos, and play voice 
memos.

•	 Memos will be added to all photographs taken while a memo list file is present in the camera’s internal 
memory or on the memory card inserted in the camera.

•	 For information on installing the supplied software, see the “Software User Guide”.
•	 The supplied software is available for Windows only.
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Section 2   
Creating and Transferring a Memo List

Creating a Camera Memo List
To create a camera memo list, use the provided 
software List Editor.

To create a memo list, first create a list of up to 
20 items and then create up to 99 descriptions 
for each item.

•	 A camera memo list file in CSV format created 
by a different application can be read into the 
List Editor and saved on an SD memory card 
for use by the camera.

•	 To read a csv format camera memo list file into 
List Editor, select [Open] from the [File] menu 
of List Editor, and then specify the file name.

Starting and Exiting List Editor

Starting List Editor
On the Windows [Start] menu, select [All 
Programs] or [Programs] then [Caplio Software] 
then [List Editor] to start List Editor.

Exiting List Editor
You can exit List Editor by clicking the [×] 
(Close) button in the upper-right corner of the 
window or by selecting [Exit] from the [File] 
menu.

The List Editor Dialog

1
2

3

4

Item Description

1 Menu bar Operations that can be performed 
using the menus include saving, 
editing, and transferring memo lists.

2 Toolbar Click the icons in the toolbar for 
quick access to the following menu 
items:
•	  [New]: Open a dialog where 

you can create a new memo list.

•	  [Open]: Open a memo list 
that you previously saved on the 
computer.

•	  [Save]: Save the memo list to 
the computer.

•	  [Cut]/  [Copy]/  [Paste]: 
Cut, copy, or paste selected text.

•	  [Transfer to Camera]: Copy the 
memo list file to the [TEMPLATE] 
folder in the camera’s internal 
memory or on the memory card 
currently inserted in the camera.

3 Item name 	
(GP.24)

Name items in the memo list. The 
number of items can be selected 
from 20, 10, and 5 using the [Number 
of Items] option in the [File] menu.

4 Details 	
(GP.24)

Enter descriptions for the selected 
item.
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Using the List Editor
The List Editor is used to create a memo 
list containing up to 20 items with up to 99 
descriptions for each item.

1.	 Choose the number of items in the 
memo list.
Select [Number of Items] from the [File] 
menu.

Choose the number of items from [5] (the 
default setting), [10], and [20]. If desired, 
the number of items can be changed after 
the memo list is created; note, however, 
that if the list contains more items than the 
new maximum, the excess items will be 
deleted.

2.	 Enter item names.

Click an item number, enter a name in the 
[Item name] text box, and click [Update] 
to display the new name in the item list. 
Follow the same procedure to change 
existing item names.

Item names can be up to 20 characters long. 
The following characters can not be used: \ / : ? 
* " < > |. Note that the presence of any of these 
characters, commas, or multiple periods may 
corrupt the display of item names in Russian-
language operating systems.

3.	 Enter descriptions.
Select a name in the item list and edit the 
descriptions for the selected item.

Enter descriptions in the [Input] text 
box, and click [Add] to add them to the 
end of the input list. Changes to existing 
descriptions can be made by clicking the 
description and then clicking one of the 
following buttons:
•	 [Edit]: Edit the selected description.
•	 [Delete]: Delete the selected description.
•	 [Up]/[Down]: Move the selected 

description up or down in the input list.

Descriptions can be up to 32 characters long. 
The following characters can not be used: \ / : ? 
* " < > |. Note that the presence of any of these 
characters, commas, or multiple periods may 
corrupt the display of descriptions in Russian-
language operating systems.
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4.	 Complete the memo list.
Repeat Steps 2 and 3 to complete the 
memo list.

5.	 Save the memo list.
Select [Save As] in the [File] menu (memo 
lists can also be saved by clicking the  
button in the toolbar).

Confirm that [mta Files (*.mta)] is selected 
for [Save as type] (memo lists can be saved 
as CSV files, but the mta format must be 
used for memo lists intended for transfer 
to the camera). After navigating to the 
desired location and entering a file name 
of up to eight characters, click [Save] to 
save the memo list. Note that the camera 
can display only file names consisting 
entirely of unaccented (low ASCII) roman 
characters.

Although lists can be transferred directly 
to the camera without being saved, we 
recommend that you save the file before 
transfer.

To edit an existing memo list, open it using 
the [Open] option in the [File] menu. After 
editing the list, save it using the [Save] 
option in the [File] menu or by clicking the 

 button in the toolbar.
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Transferring a Memo List File 
to the Camera
Memo list files can be transferred to the camera 
from the List Editor or using a card reader.

The List Editor

1.	 Start the List Editor and connect 
the camera.
After starting the List Editor, connect the 
camera as described on P.6. Exit DL-10 if 
it starts when the camera is connected 
(GP.9).

2.	 Transfer the memo list file.
Click the [   Transfer to Camera] icon in 
the toolbar or select [Transfer to Camera] 
in the [Tools] menu. If a memory card is 
inserted in the camera, the file will be 
transferred to the [TEMPLATE] folder on 
the memory card; otherwise, it will be 
transferred to the [TEMPLATE] folder in 
internal memory.

The file will only be transferred if the 
destination device contains a [TEMPLATE] 
folder. If the destination is a memory 
card, be sure it has been formatted in the 
camera.

3.	 Click [OK].

4.	 Exit the List Editor.
Select [Exit] from the [File] menu or click 
the close box [×] at the top right corner of 
the List Editor window.

5.	 Disconnect the camera.
Remove the camera from the system and 
disconnect the USB cable as described 
on P.9 (note that if the connection is not 
terminated normally, the memo list file 
may not be transferred to the camera). The 
memo list will be available for use when 
the camera is turned on.

Card Readers
A card reader can be used to copy a memo list 
file directly to the camera from the computer. 
Copy the file to the [TEMPLATE] folder on the 
memory card. A [TEMPLATE] folder is created 
automatically when a card is formatted in the 
camera.

Deleting Memo List Files From 
Memory Cards
To prevent memos from being added to 
photographs, use a computer to delete all 
“*.mta” files from the [TEMPLATE] folder on 
the memory card or in the camera’s internal 
memory. Memo list files can not be deleted 
by formatting the memory card or internal 
memory using the format option in the camera 
setup menu.
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Section 3   
Taking Photographs with Memos

Recording Memos with 
Photographs
Before proceeding, confirm that a memo list file 
has been transferred to the camera’s internal 
memory or to the memory card inserted in the 
camera.

Adding Memos to New Photos

1.	 Select 5/V mode and press 
ADJ./MEMO.
The camera memo dialog will be displayed.

Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

Client
Const.type
Location
Supervisor
Affiliates

FileName/SAMPLE

Camera Memo 1/2

Memo OnFILE LIST

If the camera contains multiple memo list 
files, the most recently-used file will be 
displayed.

While the camera memo dialog is 
displayed, photos can still be taken by 
pressing the shutter-release button.

2.	 Create a memo.
Choose descriptions as described on P.28.

3.	 Press MENU/OK.
Press MENU/OK to accept the current 
memo.

4.	 Take photographs.
The memo will be added to all new photos.

Multiple Memo List Files
If the camera contains more than one memo list 
file, press DISP. to display a list of files. Press ! 
or " to highlight a file and press MENU/OK to 
select.

SAMPLE01
SAMPLE02
SAMPLE03
SAMPLE04
SAMPLE05
SAMPLE06
SAMPLE07
SAMPLE08

01
02
03
04
05
06
07
08

FILE LIST 1/2

Cancel Execute

•	 If [On] is selected for [Display Memo at Startup] 
in the camera memo menu, the camera memo 
dialog will be displayed automatically at 
camera startup.

•	 Memos will be added to all photographs 
taken while a memo list file is present on the 
camera.  To prevent memos from being added 
to photographs, use a computer to delete all 
“*.mta” files from the [TEMPLATE] folder on 
the memory card or in the camera’s internal 
memory. Memo list files can not be deleted 
by formatting the memory card or internal 
memory using the format option in the camera 
setup menu.

•	 Note that the camera can display only file 
names consisting entirely of unaccented (low 
ASCII) roman characters.
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Choosing Descriptions
Descriptions can be selected in the camera 
memo dialog. The method used depends on 
the option selected for [Camera Memo Mode] in 
the camera memo menu.

[Mode1]

1.	 Highlight an item.
Press ! or " to highlight an item.

2.	 View descriptions.
Press $ to view descriptions for the 
highlighted item.
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3. Location 1/2

Cancel Execute

3.	 Choose a description.
Press ! or " to highlight a description 
and press MENU/OK to select.

4.	 Complete the memo.
Repeat Steps 1–3 to choose descriptions 
for the remaining items.

•	 The last option in the list of descriptions is 
[No Setting]. Select this option to set the 
description for the current item to [No Setting]. 
Note however that if [On] is selected for [Memo 
Warning], a warning will be displayed and the 
shutter release will be disabled if you attempt 
to take a photograph with the description for 
one or more memo items set to [No Setting]. 
The shutter release can be enabled by choosing 
a description for the affected items.

•	 If [On] is selected for [Camera Memo 1 Auto 
Delete], the description for the first memo 
item will automatically be set to [No Setting] 
when the camera is turned on, a photograph 
is taken, or a memo list is transferred to the 
camera. The shutter release can be enabled by 
choosing a description for the first item.

[Mode2]
When the camera memo dialog is first 
displayed, the description for each item will be 
set to the first entry in that item’s description 
list. Press $ once to set the description for each 
item to the second entry in the description 
list, twice to set the description for each item 
to the third entry in the description list, and 
so on. Press # to return to the previous set of 
descriptions.

Company A
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Exterior
Beverly Beech
Gamma Company

Client
Const.type
Location
Supervisor
Affiliates

FileName/SAMPLE

Camera Memo 1/45

FILE LIST Memo On

Shows the position of the current memo and 
the total number of combinations available. In 
this example, the current memo uses the first 
combination.

Press ! or " to choose the item displayed. The 
descriptions for individual items can not be 
selected separately.

To skip to the previous or next combination 
that contains a unique description for the item 
selected for [Memo Skip] in the camera memo 
menu, press and hold # or $. The following 
table gives an example of the combinations that 
would be skipped when [Item 1] is selected.

Item Description 1 Description 2 Description 3 Description 4

1 A A A B

The item used for [Memo Skip] can selected from 
items 1–5.
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Viewing Memos
Follow the steps below to view and edit photos 
that have been added to photographs.

•	 Memos can not be deleted.
•	 Camera memos can only be edited as 

described below when [Mode1] is selected for 
[Camera Memo Mode] in the camera memo 
menu. In Mode2, memos can be displayed by 
pressing DISP. during playback but can not be 
edited.

Viewing Memos

1.	 Display the desired photo in 
playback mode.
Photographs to which memos have been 
added are indicated by a “MEMO” icon.

2.	 Press ADJ./MEMO.
The memo will be displayed as shown 
below. Press ! or " to view additional 
data.
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Memo On

3.	 Press MENU/OK.
Press MENU/OK to return to normal 
playback.

Editing Memos

1.	 Display the desired photo in 
playback mode.
Photographs to which memos have been 
added are indicated by a “MEMO” icon.

2.	 Press ADJ./MEMO.
The memo will be displayed as shown 
below.
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3.	 Select an item.
Press ! or " to highlight an item and 
press $ to view descriptions for the 
highlighted item.
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4.	 Choose a description.
Press ! or " to highlight a description 
and press MENU/OK to select.

5.	 Press MENU/OK.
Press MENU/OK to return to normal 
playback.
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Creating a Temporary Memo
Memo descriptions can be created on the 
camera (either by editing existing descriptions 
or creating entirely new descriptions) and the 
resulting “temporary memo” appended to new 
photos. Temporary memos can be created in 
both shooting and playback mode.

•	 Temporary memos are not stored in the memo 
list after the camera is turned off.

•	 Temporary memos can be created using 
barcodes (GP.36).

•	 Temporary memos are available only when 
[Mode1] is selected for [Camera Memo Mode] 
in the camera memo menu.

Creating a Temporary Memo
To create a temporary memo, display the 
camera memo dialog and follow the steps 
below.

1.	 Select an item.
Press ! or " to highlight an item and 
press $ to view descriptions for the 
highlighted item.

2.	 Select [Temporary].
Press ! or " to highlight [Temporary] and 
press MENU/OK.
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Cancel Execute

3.	 Select [Yes].
Press # or $ to highlight [Yes] and press 
MENU/OK.

4.	 Create a temporary description.
An on-screen keyboard will be displayed. 
Use the keyboard to enter a temporary 
description as described on P.49.
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After entering the description, press ADJ./
MEMO to return to the description list.

5.	 Select the temporary description.
Press ! and " to highlight the temporary 
description and press MENU/OK to select 
(to exit without saving the temporary 
description and restore the description 
previously selected, press DISP.). Repeat 
Steps 1–4 to create additional temporary 
descriptions as desired.
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Editing the Temporary Memo

1.	 Select an item.
In the camera memo dialog, press ! or " 
to highlight an item for which you have 
created a temporary description and press 
$ to view descriptions for the highlighted 
item.

2.	 Select a temporary description.
Temporary descriptions are indicated by a 
“+”. Press ! or " to highlight a temporary 
description and press $.
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3.	 Edit the description.
Edit the description as described in Steps 
3–5 of “Creating a Temporary Memo.”

Creating a Temporary Memo from an 
Existing Memo
Create a temporary memo by editing an 
existing memo.

1.	 Select an item.
Press ! or " to highlight an item in the 
camera memo dialog and press $ to view 
descriptions for the highlighted item.

2.	 Select a description.
Press ! or " to highlight a description 
and press $.
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3.	 Edit the description.
Edit the description as described in Steps 
3–5 of “Creating a Temporary Memo.”

Edited descriptions are stored as a temporary 
memo. The original descriptions are not affected.
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Memo Increment
If a memo description ends in a number, 
you can increase or decrease the number by 
pressing ! or ".

Memo increment is available only when [Mode1] 
is selected for [Camera Memo Mode] in the 
camera memo menu.

Using Memo Increment
Transfer to the camera a memo list file 
containing descriptions that end in numbers 
and follow the steps below.

1.	 Select [On] for [Memo Increment].
Select [On] for [Memo Increment] in the 
camera memo menu.

2.	 Select an item.
Press ! or " to highlight an item in the 
camera memo dialog and press $ to view 
descriptions for the highlighted item.

3.	 Select a description that ends in a 
number.
Press ! or " to highlight a description 
that ends in a number and press $ to 
display the memo increment dialog.

No.102

Camera Memo

Cancel Ok
Change Number

A warning will sound if you select a 
description that does not end in a number.

4.	 Edit the number.
Press ! or " to choose a new number and 
press MENU/OK twice to return to shooting 
mode. The new number will be recorded 
with the next photograph taken.

The new number is stored as a temporary memo. 
The original description is not affected.
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Using Memo Increment with 
Temporary Memos
Memo increment can be used with temporary 
memos.

1.	 Create a temporary description 
that ends in a number (GP.30).

2.	 Select [On] for [Memo Increment].
Select [On] for [Memo Increment] in the 
camera memo menu.

3.	 Select the item.
In the camera memo dialog, press ! or " 
to highlight the item with the temporary 
description you created in Step 1 and press 
$ to view descriptions for the highlighted 
item.

4.	 Select the temporary description.
Temporary descriptions are indicated 
by a “+”. Press ! or " to highlight the 
description and press $ to display the 
memo increment dialog.

No.102

Camera Memo

Cancel Ok
Change Number

5.	 Edit the number.
Press ! or " to choose a new number and 
press MENU/OK twice to return to shooting 
mode. The new number will be recorded 
with the next photograph taken.

Voice Memos
Each item in a memo can have as a description 
an audio recording of up to 30 seconds in 
length. Voice memos can be created and edited 
in both shooting and playback mode.

•	 Voice recordings are deleted from the memo 
list when the camera is turned off. Voice 
recordings already stored in memos that have 
been appended to photos are not affected.

•	 Voice memos can be played back on the 
computer when photographs are displayed in 
the supplied ME1 software.

Recording Voice Memos

1.	 Select an item.
Press ! or " to highlight an item in the 
camera memo dialog and press $ to view 
descriptions for the highlighted item.

2.	 Select [Record].
Press ! or " to highlight [Record] and 
press MENU/OK to display the recording 
dialog.
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3.	 Record a voice memo.
Press the shutter-release button to begin 
recording. 

O
00:00/00:30

:Cancel
Shutter button: Start

Recording ends after 30 seconds or 
when the shutter-release button is 
pressed halfway. The description list 
will be displayed with a $ icon next to 
the [Record] option (in playback mode, 
[Record] changes to [Playback]).
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4.	 Press MENU/OK.
Items for which a recording exists are 
indicated by a v icon in the camera memo 
dialog.
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•	 Do not obstruct the microphone during 
recording. Keep microphone within 20 cm 
(7.8 in.) of the source.

•	 Voice memos are not available with matrix 
barcodes. The [Record] option is not displayed 
in the description list when a matrix barcode 
type is selected.

Playing Voice Memos
Voice memos can only be played back in 
playback mode.

1.	 Select an item for which a 
recording exists.
In the camera memo dialog, press ! or " 
to highlight an item marked with a v icon 
and press $ to view descriptions for the 
highlighted item.
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Cancel Execute

2.	 Select [Playback].
Press ! or " to highlight [Playback] and 
press $ to display the playback dialog.

:Cancel
Shutter button: Start

00:00
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3.	 Play the recording.
Press the shutter-release button to play the 
recording.

Playback ends when the end of the 
recording is reached or when the shutter-
release button is pressed halfway. A 
confirmation dialog will be displayed.

To re-record the memo as described in 
Step 3 of “Recording Voice Memos,” press 
# or $ to highlight [Yes] and press MENU/
OK. Select [No] to return to the description 
list without modifying the recording.

Re-recording Voice Memos
Follow the steps below to edit voice memos in 
shooting mode.

1.	 Select an item for which a 
recording exists.
In the camera memo dialog, press ! or " 
to highlight an item for which a recording 
exists and press $ to view descriptions for 
the highlighted item.

Temporary
Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom

+

01
02
03
04
05
06

3. Location 1/2

Cancel Execute

2.	 Select [Record].
Press ! or " to highlight [Record] and 
press $ to display the recording dialog.

O
00:00/00:30

:Cancel
Shutter button: Start

Re-record the voice memo as described in 
Step 3 of “Recording Voice Memos.”
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Registering Barcode Data as a 
Temporary Memo
The camera can read barcodes and store the 
data as temporary descriptions for temporary 
memos. Barcodes can be read in both shooting 
and playback mode.

•	 The camera can read linear barcodes of up to 
32 digits and matrix barcodes of up to 2400 
digits. The barcode type can be selected using 
the [Barcode Type] option in the camera memo 
menu.

•	 Voice memos are not available with matrix 
barcodes. The [Record] option is not displayed 
in the description list when a matrix barcode 
type is selected.

Choosing a Barcode Mode
The [Barcode Mode] option in the camera 
memo menu can be used to choose where 
barcode data are stored.

Mode1 The barcode is stored in the memo list as 
a temporary description for the first item. 
This description is overwritten each time a 
barcode is read.

Mode2 The first barcode read is stored in the memo 
list as a temporary description for the first 
item, the second barcode as a temporary 
description for the second item, the third 
barcode as a temporary description for 
the third item, and the fourth barcode as a 
temporary description for the fourth item. 
These descriptions are overwritten in turn as 
new barcodes are read.

Mode3 This option only takes effect in shooting 
mode. Up to fifty barcodes can be stored in 
the memo list as temporary descriptions for 
the first item. These data can be viewed in 
the camera memo dialog before shooting but 
can not be changed and are deleted after a 
photograph is taken.

Reading a Barcode and Registering 
Barcode Data

Shooting Mode

1.	 Press the ADJ./MEMO button.
The [Camera Memo] screen appears.

2.	 Point the camera toward the 
barcode you want to read and press 
the # button.
The camera switches to macro mode and 
reads the barcode data. When the camera 
finishes reading the barcode, the data are 
stored as a temporary description for the 
first item in the memo.

1234567890
Foundation work
Exterior
Beverly Beech
Gamma Company

Barcode
Const.type
Location
Supervisor
Affiliates

FileName/SAMPLE

Camera Memo 1/45

FILE LIST Memo On

If the camera is unable to read the barcode 
or if you wish to exit without reading the 
barcode, press $ or DISP. to return to the 
camera memo dialog. Press # to read the 
barcode again.

Non-ASCII characters in the barcode data 
will be replaced by asterisks (“*”).

3.	 Read additional barcodes.
If [Mode2] or [Mode3] is selected for 
[Barcode Mode], repeat Step 2 to read 
additional barcodes.
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4.	 Press MENU/OK to accept the new 
memo.
The new memo will be recorded with the 
next photograph taken.

To delete barcodes read with [Mode3] 
selected for [Barcode Mode], highlight the 
first item in the camera memo dialog and 
press $ to display the description list. Press 
! or " to highlight [No Setting] and press 
MENU/OK.

Playback Mode

1.	 Display a photograph.
Display a photograph to which you wish to 
add barcode data.

2.	 Press the ADJ./MEMO button.
The [Camera Memo] screen appears.

3.	 Press the # button.
You can now read barcode data.

4.	 Point the camera toward the 
barcode you want to read and press 
the # button.
The camera switches to macro mode and 
reads the barcode data. When the camera 
finishes reading the barcode, the data are 
stored as a temporary description for the 
first item in the memo.

1234567890
Foundation work
Exterior
Beverly Beech
Gamma Company

Barcode
Const.type
Location
Supervisor
Affiliates

FileName/SAMPLE

Camera Memo 1/45

Ok

If the camera is unable to read the barcode 
or if you wish to exit without reading the 
barcode, press $ or DISP. to return to the 
camera memo dialog. Press # to read the 
barcode again.

Non-ASCII characters in the barcode data 
will be replaced by asterisks (“*”).

5.	 When [Barcode Mode] is set to 
[Mode2], you can repeat Step 4 and 
read additional barcodes.

6.	 Press the MENU/OK button to 
confirm the camera memo.

7.	 Press the MENU/OK button.
The memo will be added to the 
photograph.

•	 You cannot read the same barcode more than 
once.

•	 If, after reading the barcode, you shoot a 
picture or change modes and then read 
another barcode, the previously registered 
barcode data is overwritten.

•	 If you edited the camera memo before reading 
a barcode, the changes to the camera memo 
are not retained if the camera is unable to 
read the barcode. However, voice memos are 
retained.

•	 You can edit the barcode data registered as a 
temporary memo. (GP.31)

•	 The time available to read barcodes can be 
selected using the [Scan Time] option in the 
camera memo menu.
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Image Memos
To use still images as memos, include a 
description with an image file name when 
creating the memo list. Note that the image 
file must first be copied to the camera memory 
card or internal memory.

Image memos can be viewed only when [Mode2] 
is selected for [Camera Memo Mode] in the 
camera memo menu. No image will be displayed 
if a file with the selected name can not be found.

First Steps

1.	 Enter the image file name as a 
description.
Using the supplied List Editor application, 
enter the file name of the desired image as 
a description for the last item in the item 
list (GP.23).

•	 Enter the file name as the description for the 
last item in the item list. The image will not 
be displayed if the file name is entered as a 
description for other items in the list.

•	 Image memo file names must end in the “.jpg” 
extension.

2.	 Connect the camera to the 
computer.
See “Downloading Images Without Using 
DL-10“ (GP.6) for more information.

3.	 Copy the image to the camera.
Copy the image to the [TEMPLATE] folder 
in internal memory or on the camera 
memory card.

Image memos must satisfy all the following 
criteria:
•	 File type: JPEG
•	 Color space: YCbCr 4 : 2 : 2 or 4 : 2 : 0
•	 Dimensions (W × H): From 32 × 32 to 

4000 × 3000 pixels, where the width is a 
multiple of 16 and the height a multiple of 8 
(YCbCr 4 : 2 : 2) or 16 (YCbCr 4 : 2 : 0)

•	 File size: 12 MB or less
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Viewing Image Memos

Shooting Mode
To view image memos, press ADJ./MEMO in the 
camera memo dialog. Press ADJ./MEMO again 
to return to the camera memo dialog.

Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

Client
Const.type
Location
Supervisor
Affiliates

FileName/SAMPLE

Camera Memo 1/45

FILE LIST Memo On

1/45

ADJ./MEMO button

Playback Mode
To view an image memo that has been 
appended to a photograph, display the 
photograph and press ADJ./MEMO.

Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

Client
Const.type
Location
Supervisor
Affiliates

Client
Const.type
Location
Supervisor
Affiliates

ADJ./MEMO button

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

Press !, ", #, or $ to return to playback and 
display other photographs.

No image memo will be displayed if a file with 
the selected name can not be found.
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Section 4   
Viewing/Editing a Camera Memo  

on a Computer
Using ME1
Once photographs have been transferred to 
the computer, the supplied ME1 software can 
be used to display photographs, view and edit 
memos, and play voice memos.

Select [Programs] (or [All Programs]) > 
[DC Software] > [ME1] from the Windows [Start] 
menu to start the software.

The ME1 Window
1

2

3

Item Description

1 Menu bar Operations that can be performed 
using the menus include printing and 
viewing photographs.

2 Folder list A list of the folders on the computer. 
Click a folder to display any photographs 
it contains in the thumbnail list.

3 Thumbnail 
list

A list of the photographs in the selected 
folder. Double-click a thumbnail to 
display the photograph full frame. The 
following icons are displayed under the 
photos in the thumbnail list:
•	  (GPS icon): Double-click this icon 

to display GPS data recorded with the 
photo. If no GPS data are recorded 
with the photo, this icon will be 
grayed out and unavailable.

•	  (memo icon): Double-click this 
icon to edit the memo appended 
to the photo. If no memo has been 
added to the photo, this icon will be 
grayed out and unavailable.

Editing Memos
To edit the memo for a selected photo, double-
click the  icon in the thumbnail list. The edit 
dialog will be displayed.

1

2

8

4
5

6
7

3

Item Description

1 Item A list of the items in the memo.

2 Voice memo 
icons

The icons for items that contain voice 
memos are displayed in red.

3 Memo The descriptions for the items in the 
item list.

4 [Play Voice 
Memo] 
button

Click to play the voice memo for the 
selected item.

5 Edit Memo Lists the item name and description 
for the item selected in the item 
list. The name and description 
can be edited by typing in the 
corresponding text box (the 
following characters can not be used: 
\ / : ? * " < > |).

6 [Apply] 
button

Click to apply the changes in the 
[Edit Memo] panel.

7 [Save] 
button

Save changes and close the edit 
dialog.

8 [Cancel]	
button

Close the edit dialog. Any changes 
made since the last time you clicked 
the [Apply] button will be lost.



41

•	 No photographs will be displayed if a space 
occurs at the beginning or end of the folder 
name. Edit the folder name.

•	 Note that the presence of commas, multiple 
periods, or any of the following characters may 
corrupt the display of item names in Russian-
language operating systems: \ / : ? * " < > |

Printing Memos with Photographs
Select [Print] in the [File] menu to print memos 
with photographs. Printer settings can be 
adjusted by selecting [Settings] in the [File] 
menu.

Print Samples
Single photo printed with memo on an A4 sheet

Category01 Cameramemo01_01
Category02 Cameramemo02_01
Category03 Cameramemo03_01
Category04 Cameramemo04_01
Category05 Cameramemo05_01
Category06 Cameramemo06_01
Category07 Cameramemo07_01
Category08 Cameramemo08_01
Category09 Cameramemo09_01
Category10 Cameramemo10_01
Category11 Cameramemo11_01
Category12 Cameramemo12_01
Category13 Cameramemo13_01
Category14 Cameramemo14_01
Category15 Cameramemo15_01
Category16 Cameramemo16_01
Category17 Cameramemo17_01
Category18 Cameramemo18_01
Category19 Cameramemo19_01
Category20 Cameramemo20_01

C:myPicture 2010/0101

RIMG0001. jpg 2010/01/10

Two photos printed with memos on an A4 sheet

C:myPicture 2010/0101

Category01 Cameramemo01_01
Category02 Cameramemo02_01
Category03 Cameramemo03_01
Category04 Cameramemo04_01
Category05 Cameramemo05_01
Category06 Cameramemo06_01
Category07 Cameramemo07_01
Category08 Cameramemo08_01
Category09 Cameramemo09_01
Category10 Cameramemo10_01
Category11 Cameramemo11_01
Category12 Cameramemo12_01
Category13 Cameramemo13_01
Category14 Cameramemo14_01
Category15 Cameramemo15_01
Category16 Cameramemo16_01
Category17 Cameramemo17_01
Category18 Cameramemo18_01
Category19 Cameramemo19_01
Category20 Cameramemo20_01

Category01 Cameramemo01_01
Category02 Cameramemo02_01
Category03 Cameramemo03_01
Category04 Cameramemo04_01
Category05 Cameramemo05_01
Category06 Cameramemo06_01
Category07 Cameramemo07_01
Category08 Cameramemo08_01
Category09 Cameramemo09_01
Category10 Cameramemo10_01
Category11 Cameramemo11_01
Category12 Cameramemo12_01
Category13 Cameramemo13_01
Category14 Cameramemo14_01
Category15 Cameramemo15_01
Category16 Cameramemo16_01
Category17 Cameramemo17_01
Category18 Cameramemo18_01
Category19 Cameramemo19_01
Category20 Cameramemo20_01

Three photos printed with memos on an A4 sheet

C:myPicture 2010/0101

RIMG0001. jpg
2010/0101

Category01 Cameramemo01_01
Category02 Cameramemo02_01
Category03 Cameramemo03_01
Category04 Cameramemo04_01
Category05 Cameramemo05_01
Category06 Cameramemo06_01
Category07 Cameramemo07_01
Category08 Cameramemo08_01
Category09 Cameramemo09_01
Category10 Cameramemo10_01

RIMG0002. jpg
2010/0101

Category01 Cameramemo01_01
Category02 Cameramemo02_01
Category03 Cameramemo03_01
Category04 Cameramemo04_01
Category05 Cameramemo05_01
Category06 Cameramemo06_01
Category07 Cameramemo07_01
Category08 Cameramemo08_01
Category09 Cameramemo09_01
Category10 Cameramemo10_01

RIMG0003. jpg
2010/0101

Category01 Cameramemo01_01
Category02 Cameramemo02_01
Category03 Cameramemo03_01
Category04 Cameramemo04_01
Category05 Cameramemo05_01
Category06 Cameramemo06_01
Category07 Cameramemo07_01
Category08 Cameramemo08_01
Category09 Cameramemo09_01
Category10 Cameramemo10_01

•	 Photos can be printed without memos.
•	 The number of memo items that can be 

printed with three photos on a single sheet 
varies with printer settings.
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Section 5   
Using Memos to Sort Photos

Using EX1
The supplied EX1 software can be used to:

•	 Rename photographs or organize 
photographs into folders using memo 
data, allowing you to get an idea of memo 
contents from the image file names

•	 Export memos in CSV, XML, or TXT format

EX1 is available in client and server versions. The 
server version (“EX1 for Server”) continuously 
monitors a selected source folder for new 
images and automatically processes them as 
they are added to the folder. The client version 
(“EX1 for Client”) does not process images 
automatically.

EX1 Operation Flow

1.	 Copy photos to the computer 
(GP.5).
Copy photographs with memos to the 
computer, either using DL-10 or by another 
method.

2.	 Adjust transfer settings (GP.43).
Choose source and destination folders.

3.	 Process photographs.
The server version of EX1 automatically 
processes photos as they are added to the 
source folder (GP.45); to process photos 
using the client version, select [Programs] 
(or [All Programs]) > [EX1 for Client] > 
[Transfer] from the Windows [Start] menu 
(GP.45).

Starting and Exiting EX1

EX1 for Server
When installed using the default installation 
options, EX1 resides permanently in the system 
tray. To close EX1, click the icon in the system 
tray and select [Quit].

To restart EX1, select [Programs] (or [All 
Programs]) > [EX1 for Server] from the Windows 
[Start] menu.

EX1 for Client
To adjust settings, select [Programs] (or [All 
Programs]) > [EX1 for Client] > [Setting] 
from the Windows [Start] menu. To process 
photos, select [Programs] (or [All Programs]) > 
[EX1 for Client] > [Transfer]. To exit EX1, close 
the transfer settings dialog. EX1 will terminate 
automatically when processing is complete.
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Transfer Settings

EX1 for Server
Clicking the EX1 icon in the system tray with 
the right mouse button displays the following 
transfer settings dialog.

1

4

2

3

Item Description

1 Transfer 
From

Click [Browse…] to choose the 
watched folder.

2 Process Choose how photographs will be 
processed.
•	 Camera memo extraction: Rename 

files according to memo contents 
and transfer them to the selected 
destination folder, or export memos 
in CSV, XML, or TXT format.

•	 Camera memo category: Create sub-
folders in the selected destination 
folder named according to memo 
contents and transfer files to the 
appropriate sub-folders.

Click [Detail...] to adjust settings for 
the selected option (GP.44).

3 Save To Click [Browse…] to choose a 
destination folder.

4 [OK] button Save changes and exit.

EX1 for Client
Select [Programs] (or [All Programs]) > 
[EX1 for Client] > [Setting] from the Windows 
[Start] menu.

1

5

2

3

4

Item Description

1 Transfer From Click [Browse…] to choose the 
folder containing the images you 
intend to process.

2 Process Choose how photographs will 
be processed as described under 
“EX1 for Server.”

3 Save To Click [Browse…] to choose a 
destination folder.

4 [Display 
confirmation 
dialog before 
transfer begins]

Select this option to display 
a confirmation dialog before 
transfer begins (GP.45)

5 [OK] button Transfer photos. The original files 
will be deleted when transfer 
is complete. (The first time you 
start EX1 for Client, this button is 
displayed as [Begin Transfer].)

If [Camera memo extraction] is selected for 
[Process], reserved characters (\ / : ? * " < > |) are 
automatically converted to underscores (“_”) 
when memo item names and descriptions are 
used as folder names.
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Process > Detail
Clicking [Detail...] in the [Process] panel displays 
the following dialog.

The items in the setting information list depend 
on the option selected in the [Process] panel. To 
change settings, highlight an item in the setting 
information list and click [Change...].

Camera Memo Extraction > Rename Syntax

Choose the memo items that will be used to 
rename files. If multiple items are selected, they 
will be separated by an underscore (“_”) in the 
file name.

Camera Memo Extraction > Export Format

Select the format or formats that will be used to 
export memos. Memos will not exported if no 
options are selected.

Camera memo category > Transfer Mode

Choose whether folder names will consist of 
the item name and description separated by an 
underscore (“_”) or simply the description.

Example: Given the following camera memo…

Item Name Description

Item 1 Description A

Item 2 Description B

Item 3 Description C

Item 4 Description D

…the following folders will be created using 
the item names and descriptions:

Item 1_Description A

Item 1_Description B

Item 1_Description C

Item 1_Description D
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Processing Photos

EX1 for Server
If folder monitoring is enabled, EX1 will monitor 
the folder selected in the transfer settings 
dialog and automatically process images as 
they are added to the folder. Disable folder 
monitoring to prevent images from being 
processed automatically.

If a transferred file is found to be damaged or 
corrupt, a message will be displayed and transfer 
will end automatically.

EX1 for Client
Select [Programs] (or [All Programs]) > 
[EX1 for Client] > [Transfer] from the Windows 
[Start] menu. If [Display confirmation dialog 
before transfer begins] is selected in the 
transfer options dialog, the following dialog 
will be displayed. Click [Transfer] to transfer the 
images.

The original files are deleted after transfer.

Property
To open the EX1 for Server properties dialog, 
right click the EX1 icon in the system tray.

1

2

Item Description

1 Setting for 
application 
launching

Choose whether folder monitoring is 
enabled by default.

2 Enable the 
output of 
transfer log

Choose whether a log file will be 
created when images are transferred.
•	 Browse…: Choose a destination for 

the log file.

•	 Maximum file size: Choose the 
maximum size for the log file.

•	 History of file number: Choose 
the number of files included in the 
transfer history.
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File Information
The information below is included in files 
created using [Export Format].

This example assumes that the following file is 
transferred:

File Description

Item Content

Date of recording 2010.10.10 00:00:00

GPS data None

Memo Contents

Item Name Description

Item 1 Description A

Item 2 Description B

Item 3 Description C

Item 4 Description D

Item 5 Description E

XML Format

Main Tag Name Content

DateTimeOriginal Shooting date of the image file

GPSLatitudeRef Latitude (N or S)

GPSLatitude Latitude (Numeric value)

GPSLongitudeRef Longitude (E or W)

GPSLatitude Longitude (Numeric value)

CameraMemo1–
CameraMemo5 Item names and descriptions

MemoItem1–
MemoItem5 Item names

MemoData1–
MemoData5 Descriptions

<?xml version="1.0" encoding="Shift_JIS"?>
<Exif>

<APP1>
<Exif_IFD>

<DateTimeOriginal>2010:10:10 00:00:00
</DateTimeOriginal>

</Exif_IFD>
<GPS_IFD>

<GPSLatitudeRef>N</GPSLatitudeRef>
<GPSLatitude>00:00:00</GPSLatitude>
<GPSLongitudeRef>E</GPSLongitudeRef>
<GPSLongitude>00:00:00</GPSLongitude>

</GPS_IFD>
</APP1>
<APP5>

<CameraMemo1>
<MemoItem1>Item 1</MemoItem1>
<MemoData1>Description A</MemoData1>

</CameraMemo1>
<CameraMemo2>

<MemoItem2>Item 2</MemoItem2>
<MemoData2>Description B</MemoData2>

</CameraMemo2>
<CameraMemo3>

<MemoItem3>Item 3</MemoItem3>
<MemoData3>Description C</MemoData3>

</CameraMemo3>
<CameraMemo4>

<MemoItem4>Item 4</MemoItem4>
<MemoData4>Description D</MemoData4>

</CameraMemo4>
<CameraMemo5>

<MemoItem5>Item 5</MemoItem5>
<MemoData5>Description E</MemoData5>

</CameraMemo5>
</APP5>

</Exif>
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CSV Format

Main Tag Name Content

DateTimeOriginal Shooting date of the image file

GPSLatitudeRef Latitude (N or S)

GPSLatitude Latitude (Numeric value)

GPSLongitudeRef Longitude (E or W)

GPSLatitude Longitude (Numeric value)

(Memo item 
names and 
descriptions)

The above information is 
followed by the memo item 
names and descriptions.

DateTimeOriginal,2010:10:10 00:00:00
GPSLatitudeRef,N
GPSLatitude,00:00:00
GPSLongitudeRef,E
GPSLatitude,00:00:00
Item 1, Description A
Item 2, Description B
Item 3, Description C
Item 4, Description D
Item 5, Description E

TXT Format

Main Tag Name Content

DateTimeOriginal Shooting date of the image file

GPSLatitudeRef Latitude (N or S)

GPSLatitude Latitude (Numeric value)

GPSLongitudeRef Longitude (E or W)

GPSLatitude Longitude (Numeric value)

CameraMemo1–
CameraMemo5

Memo item names and 
descriptions

[DateTimeOriginal]
2010:10:10 00:00:00
[GPSLatitudeRef ]
N
[GPSLatitude]
00:00:00
[GPSLongitudeRef ]
E
[GPSLatitude]
00:00:00
[CameraMemo1]
Item 1
Description A
[CameraMemo2]
Item 2
Description B
[CameraMemo3]
Item 3
Description C
[CameraMemo4]
Item 4
Description D
[CameraMemo5]
Item 5
Description E



Appendices
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How to Use the Keyboard
To use the keyboard, follow the steps below.

D

Camera Memo

Cancel Ok
Shift Set

A
H
O
V
(

B
I
P
W
)

C
J
Q
X
<

D
K
R
Y
>

E
L
S
Z
[

F
M
T
!
]

G
N
U
?
&

/
,
~

-
.
*

+
=
^

1
4
7
@
_

2
5
8
#
”

3
6
9
%
’

$
\
0
|
`

[Space]
[Delete]

Memo area

Keyboard area

1.	 Enter a description of up to 32 characters.
Highlight characters using !, ", #, or $ and press MENU/OK to enter the highlighted 
character at the current cursor position (to delete the character at the current cursor position, 
select [Delete]). Press D to shift between upper and lower case. To exit without changing the 
description, press the DISP. button.

2.	 Press ADJ./MEMO.
Press ADJ./MEMO to save the description and exit the keyboard entry dialog.
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Troubleshooting
Problem 1	 Cannot download images

Solution 1

Your camera may not be recognized correctly if you connect to the USB Port of your computer via a USB hub.

Follow the steps below to change the USB port.

•	 Connect your camera directly to the USB port of your computer.

•	 If there are several root hubs, change to another hub.

If you are using a non-USB hub, try connecting via a USB hub.

Solution 2

The battery in the camera may have worn out.

Before downloading images from your camera, load a battery with adequate remaining power in the 
camera.

Solution 3

The free space on the hard disk in your computer may be insufficient.

Check whether the hard disk has sufficient space for running Windows, and whether the drive where 
you are loading image files has the same capacity or more as that of the SD memory card inserted in 
the camera.

Problem 2	 Even if you check [The same image will not be saved] in the DL-10 [Option settings], the 
same images are loaded into your computer.

Solution

The camera's clock is incorrectly set or the camera's clock information has been reset.

To allow the [The same image will not be saved] function to work properly, the camera's clock 
information must be set properly. Set it properly.

Problem 3	 Files loaded from the camera into the computer were deleted. You attempted to load 
the same files from the camera again but failed. 

Solution

If [The same image will not be saved] is checked in the DL-10 [Option settings], files loaded into your 
computer once cannot be loaded again. In the DL-10 [Option settings], uncheck [The same image will 
not be saved].

Problem 4	 [Failed to save.] appears during image loading from the camera into your computer

Solution

Set the camera to playback mode and check that [Unmatched File] is not displayed for any file. If 
[Unmatched File] is displayed, delete the file from the SD memory card or internal memory after 
backing up all files on your computer. To back up the files in the camera, copy all files into your 
computer directly by using a commercially-available card reader or by connecting the camera to the 
computer using the USB cable provided.


	Using These Manuals
	1. Understanding How to Use Your Camera
	2. Downloading Images to Your Computer
	3. Displaying Images on Your Computer

	How to Use the Software User Guide
	Display examples:
	Terms:
	Symbols:

	Contents
	Chapter 1 Downloading Images to Your Computer (Windows)
	Downloading Images
	Downloading Images Without Using DL-10
	Downloading All Images Using the DL-10 Software
	Warning Messages Under Windows XP Service Pack 3 and Windows Vista Service Pack 2
	Windows 7 Security Warning
	Disconnecting the Camera from Your Computer
	Detailed Instructions for DL-10
	Starting/Exiting DL-10
	The DL-10 Window
	How to Use the [Option settings]
	How to Use the [Background illustration settings]
	Using [CameraMemo Settings]

	Downloading Images from an SD Memory Card
	Images in an SD Memory Card


	Chapter 2 Downloading Images to Your Computer (Macintosh)
	Connecting the Camera to a Computer and Downloading Images
	Disconnecting the Camera from Your Computer
	Downloading Images from an SD Memory Card
	Images in an SD Memory Card


	Chapter 3 How to Use EC1
	Using the Edit Detection Function
	Updating Folder Contents


	Chapter 4 Shooting with Camera Memos
	Section 1 About Camera Memos
	Shooting with Camera Memos
	Memos
	Using Memos


	Section 2 Creating and Transferring a Memo List
	Creating a Camera Memo List
	Starting and Exiting List Editor
	The List Editor Dialog
	Using the List Editor

	Transferring a Memo List File to the Camera
	The List Editor
	Card Readers
	Deleting Memo List Files From Memory Cards


	Section 3 Taking Photographs with Memos
	Recording Memos with Photographs
	Adding Memos to New Photos
	Choosing Descriptions

	Viewing Memos
	Viewing Memos
	Editing Memos

	Creating a Temporary Memo
	Creating a Temporary Memo
	Editing the Temporary Memo
	Creating a Temporary Memo from an Existing Memo

	Memo Increment
	Using Memo Increment
	Using Memo Increment with Temporary Memos

	Voice Memos
	Recording Voice Memos
	Playing Voice Memos
	Re-recording Voice Memos

	Registering Barcode Data as a Temporary Memo
	Choosing a Barcode Mode
	Reading a Barcode and Registering Barcode Data

	Image Memos
	First Steps
	Viewing Image Memos


	Section 4 Viewing/Editing a Camera Memo  on a Computer
	Using ME1
	The ME1 Window
	Editing Memos
	Printing Memos with Photographs


	Section 5 Using Memos to Sort Photos
	Using EX1
	EX1 Operation Flow
	Starting and Exiting EX1
	Transfer Settings
	Processing Photos
	Property
	File Information



	Appendices
	How to Use the Keyboard
	Troubleshooting


